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This Chapter Contains:

� General Guidelines for extracting RNA from eukaryotic cells or tissues using 
commercially available reagents and kits

� Detailed steps for making double-stranded cDNA from extracted RNA.
� Guidelines for producing biotin-labeled antisense cRNA (target) using in vitro 

transcription reaction (IVT) and the ENZO® BioArray™ HighYield™ RNA Transcript Labeling 
Kit

� Instructions for fragmenting the labeled cRNA target

After completing the procedures described in this chapter, the labeled and fragmented 
cRNA target is hybridized to the probe array as described in Section 2, Chapter 3.
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Reagents and Materials Required

The following reagents and materials are recommendations and have been tested and 
evaluated by Affymetrix scientists. For supplier phone numbers in the U.S. and Europe, 
please refer to the Supplier and Reagent Reference List, Appendix A, of this manual. 
Information and part numbers listed are based on U.S. catalog information. Additional 
reagents needed for the complete analysis are listed in the appropriate chapters. 
Appendix A contains a master list of all reagents used in this manual.

Total RNA Isolation
� TRIzol Reagent, Invitrogen Life Technologies, P/N 15596-018
� RNeasy Mini Kit, QIAGEN, P/N 74104

Poly-A mRNA Isolation
� Oligotex Direct mRNA Kit (isolation of mRNA from whole cells), QIAGEN, 

P/N 72012, 72022, or 72041
� Oligotex mRNA Kit (isolation of mRNA from total RNA), QIAGEN, P/N 70022, 70042, or 

70061
� Qiashredder, QIAGEN, P/N 79654 (Required only for use with QIAGEN Oligotex Direct 

Kit)
� DEPC-Treated Water, Ambion, P/N 9920

cDNA Synthesis
� GeneChip T7-Oligo(dT) Promoter Primer Kit, 

5´ - GGCCAGTGAATTGTAATACGACTCACTATAGGGAGGCGG-(dT)24 - 3´
50 µM, HPLC purified, Affymetrix, P/N 900375   

� SuperScript II, Invitrogen Life Technologies, P/N 18064-014 or 
SuperScript Choice System for cDNA Synthesis, Invitrogen Life Technologies,
P/N 18090-019

� E. coli DNA Ligase, Invitrogen Life Technologies, P/N 18052-019
� E. coli DNA Polymerase I, Invitrogen Life Technologies, P/N 18010-025
� E. coli RNaseH, Invitrogen Life Technologies, P/N 18021-071
� T4 DNA Polymerase, Invitrogen Life Technologies, P/N 18005-025
� 5X Second strand buffer, Invitrogen Life Technologies, P/N 10812-014
� 10 mM dNTP, Invitrogen Life Technologies, P/N 18427-013
� GeneChip Sample Cleanup Module, Affymetrix, P/N 900371

Synthesis of Biotin-Labeled cRNA

Do not store enzymes in a frost-free freezer.

SuperScript Choice System contains, in addition to SuperScript II Reverse 
Transcriptase, other reagents for cDNA synthesis.  However, not all components 
provided in the Choice System are used in the GeneChip cDNA synthesis protocol.

RNA Transcript Labeling Kit, Affymetrix, P/N 900182Enzo
BioArray

HighYield
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IVT cRNA Cleanup and Quantification
� GeneChip Sample Cleanup Module, Affymetrix, P/N 900371
� 10X TBE, Cambrex, P/N 50843

cRNA Fragmentation
� GeneChip Sample Cleanup Module, Affymetrix, P/N 900371

Alternative Protocol for Cleanup of Double-Stranded cDNA
� Phase Lock Gel, Brinkmann Instruments, P/N 955 15 415
� Phenol/chloroform/isoamyl alcohol, Ambion, P/N 9732
� 7.5 M Ammonium Acetate (NH4OAc), Sigma-Aldrich, P/N A2706
� Water, Molecular Biology Grade, BioWhittaker Molecular Applications / Cambrex, P/N 

51200

Miscellaneous Reagents
� Absolute ethanol (stored at -20°C for RNA precipitation; store ethanol at room 

temperature for use with the GeneChip Sample Cleanup Module)
� 80% ethanol (stored at -20°C for RNA precipitation; store ethanol at room temperature 

for use with the GeneChip Sample Cleanup Module)
� SYBR Green II, Cambrex, P/N 50523; or Molecular Probes, P/N S7586 (optional)
� Pellet Paint, Novagen, P/N 69049-3 (optional)
� Glycogen, Ambion, P/N 9510 (optional)
� 3 M Sodium Acetate (NaOAc), Sigma-Aldrich, P/N S7899
� Ethidium Bromide, Sigma-Aldrich, P/N E8751
� 1 N NaOH
� 1 N HCl
� 50 mM MgCl2 

� 0.5 M EDTA

Miscellaneous Supplies
� Sterile, RNase-free, microcentrifuge tubes, 1.5 mL, USA Scientific, P/N 1415-2600 (or 

equivalent)
� Micropipettors, (P-2, P-20, P-200, P-1000), Rainin Pipetman or equivalent
� Sterile-barrier, RNase-free pipette tips (Tips must be pointed, not rounded, for efficient 

use with the probe arrays.) Beveled pipette tips may cause damage to the array septa 
and cause leakage.

� Mini agarose gel electrophoresis unit with appropriate buffers
� Vacuum filter units (1 liter capacity, 0.22 µm or 0.45 µm), VWR Scientific Products, P/N 

28199-730
� UV spectrophotometer
� Cooling waterbath
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Isolation of RNA

Protocols are provided for preparing labeled cRNA from either total RNA or purified 
poly-A mRNA. We have found that results obtained from samples prepared by both of these 
methods are similar, but not identical. Therefore, to get the best results we suggest only 
comparing samples prepared using the same type of RNA material.

Please review precautions and interfering conditions in Section 1.
 

When using a commercial kit, follow the manufacturer’s instructions for RNA isolation.

Isolation of RNA from Yeast

Total RNA

We have successfully isolated good quality total RNA from yeast cells using a hot phenol 
protocol described by Schmitt, et al. Nucl Acids Res, 18:3091-3092 (1990).

Poly-A mRNA

Affymetrix recommends first purifying total RNA from yeast cells before isolating poly-A 
mRNA from total RNA. Good quality mRNA has been successfully isolated from total 
RNA using QIAGEN’s Oligotex mRNA Kit. A single round of poly-A mRNA selection 
provides mRNA of sufficient purity and yield to use as a template for cDNA synthesis. Two 
rounds of poly-A mRNA selection will result in significantly reduced yields of yeast mRNA 
and is not generally recommended.

Isolation of RNA from Arabidopsis

Total RNA

We have been using TRIzol Reagent from Invitrogen Life Technologies to isolate total RNA 
from Arabidopsis. Please follow the instructions provided by the supplier and, when 
necessary, use the steps outlined specifically for samples with high starch and/or high lipid 
content.

Poly-A mRNA

We have successfully isolated Arabidopsis poly-A RNA using QIAGEN Oligotex products. 
However, other standard isolation products are likely to be adequate.

The quality of the RNA is essential to the overall success of the analysis. Since the 
most appropriate protocol for the isolation of RNA can be source dependent, we 
recommend using a protocol that has been established for the tissues or cells being 
used. In the absence of an established protocol, we suggest using one of the 
commercially available kits designed for RNA isolation.



SECTION 2   Eukaryotic Sample and Array Processing

2.1.8

Isolation of RNA from Mammalian Cells or Tissues

Total RNA

We have successfully isolated high-quality total RNA from mammalian cells (such as 
cultured cells and lymphocytes) using the RNeasy Mini Kit from QIAGEN.

If mammalian tissue is used as the source of RNA, we recommend isolating total RNA with 
a commercial reagent such as TRIzol.

Poly-A mRNA

Good quality mRNA has been successfully isolated from mammalian cells (such as cultured 
cells and lymphocytes) using QIAGEN’s Oligotex Direct mRNA kit and from total RNA 
using the Oligotex mRNA kit. If mammalian tissue is used as the source of mRNA, total 
RNA should be first purified using a commercial reagent such as TRIzol and then using a 
poly-A mRNA isolation procedure or a commercial kit.

Precipitation of RNA

Total RNA

It is not necessary to precipitate total RNA following isolation or cleanup with RNeasy 
Mini Kit. Please adjust elution volumes from the RNeasy column to prepare for cDNA 
synthesis based upon expected RNA yields from your experiment. Ethanol precipitation is 
required following TRIzol isolation and hot phenol extraction methods; see methods on 
page 2.1.9.

For smaller amounts of starting material, please refer to the alternative research protocol for 
target labeling described in GeneChip Eukaryotic Small Sample Target Labeling Technical 
Note, available at www.affymetrix.com. 

Poly-A mRNA

Most poly-A mRNA isolation procedures will result in dilution of RNA. It is necessary to 
concentrate mRNA prior to the cDNA synthesis.

If going directly from TRIzol-isolated total RNA to cDNA synthesis, it may be beneficial to 
perform a second cleanup on the total RNA before starting. After the ethanol precipitation 
step in the TRIzol extraction procedure, perform a cleanup using QIAGEN RNeasy Mini 
Kit. Much better yields of labeled cRNA are obtained from the in vitro transcription-
labeling reaction when this second cleanup is performed.

Affymetrix recommends starting the cDNA synthesis protocol with a minimum of 
0.2 µg poly-A mRNA at a minimum concentration of 0.02 µg/µL, or 5 µg of total RNA 
at a minimum concentration of 0.5 µg/µL, in order to obtain sufficient quantity of 
labeled cRNA for target assessment and hybridization to GeneChip expression probe 
arrays. There are two major advantages to starting with at least the recommended 
amount of material:

1. Enough material to check sample yield and quality at the various steps of this 
protocol.

2. Production of enough cRNA for hybridization of the target to multiple probe arrays.
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Precipitation Procedure

1. Add 1/10 volume 3 M NaOAc, pH 5.2, and 2.5 volumes ethanol.*

2. Mix and incubate at -20°C for at least 1 hour.

3. Centrifuge at ≥ 12,000 x g in a microcentrifuge for 20 minutes at 4°C.

4. Wash pellet twice with 80% ethanol.

5. Air dry pellet. Check for dryness before proceeding.

6. Resuspend pellet in DEPC-treated H2O. The appropriate volume for resuspension 
depends on the expected yield and the amount of RNA required for the cDNA 
synthesis. Please read ahead to the cDNA synthesis protocol in order to determine the 
appropriate resuspension volume at this step.

*Addition of Carrier to Ethanol Precipitations

Adding carrier material has been shown to improve the RNA yield of precipitation 
reactions.

� Pellet Paint

Affymetrix has found that adding 0.5 µL of Pellet Paint per tube to nucleic acid 
precipitations makes the nucleic acid pellet easier to visualize and helps reduce the 
chance of losing the pellet during washing steps. The pellet paint does not appear to 
affect the outcome of subsequent steps in this protocol; however, it can contribute to the 
absorbance at 260 nm when quantifying the mRNA. 

� Glycogen

Addition of 0.5 to 1 µL of glycogen (5 mg/mL) to nucleic acid precipitations aids in 
visualization of the pellet and may increase recovery. The glycogen does not appear to 
affect the outcome of subsequent steps in this protocol. 

Quantification of RNA

Quantify RNA yield by spectrophotometric analysis using the convention that 1 absorbance 
unit at 260 nm equals 40 µg RNA per mL.

� The absorbance should be checked at 260 and 280 nm for determination of sample 
concentration and purity. 

� The A260/A280 ratio should be close to 2.0 for pure RNA (ratios between 1.9 and 2.1 are 
acceptable).
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Synthesis of Double-Stranded cDNA 
From Total RNA

This protocol is a supplement to instructions provided in the Invitrogen Life Technologies 
SuperScript Choice system. Please note the following before proceeding:

� Read all information and instructions that come with reagents and kits.
� Use the GeneChip T7-Oligo(dT) Promoter Primer Kit1 for priming first strand cDNA 

synthesis in place of the oligo(dT) or random primers provided with the SuperScript 
Choice kit. The GeneChip T7-Oligo(dT) Promoter Primer Kit provides high-quality HPLC-
purified T7-oligo(dT) primer which is essential for this reaction.

� It is recommended that each step of this protocol be checked by gel electrophoresis.

T7-oligo(dT) primer

5´ - GGCCAGTGAATTGTAATACGACTCACTATAGGGAGGCGG-(dT)24 - 3´

Step 1: First Strand cDNA Synthesis

Starting material: High-quality total RNA (5.0 µg - 20.0 µg)

After purification the RNA concentration is determined by absorbance at 260 nm on a 
spectrophotometer (one absorbance unit = 40 µg/mL RNA). The A260/A280 ratio should be 
approximately 2.0, with ranges between 1.9 to 2.1 considered acceptable. We recommend 
checking the quality of the RNA by running it on an agarose gel prior to starting the assay. 
The rRNA bands should be clear without any obvious smearing patterns.

Before starting cDNA synthesis, the correct volumes of DEPC-treated H2O and Reverse 
Transcriptase (RT) must be determined. These volumes will depend on both the 
concentration and total volume of RNA that is being added to the reaction.

1. Users who do not purchase the GeneChip T7-Oligo(dT) Promoter Primer Kit may be required to obtain a license under U.S. 
Patent Nos. 5,569,584, 5,716,785, 5,891,636, 6,291,170 and 5,545,522 or to purchase another licensed kit.

When using the GeneChip Sample Cleanup Module for the cDNA and IVT cRNA 
cleanup steps, there is a potential risk of overloading the columns if greater than the 
recommended amount of starting material is used.

Use Table 2.1.1 and Table 2.1.2 for variable component calculations. Determine the 
volumes of RNA and SuperScript II RT required in Table 2.1.1, then calculate the 
amount of DEPC-treated H2O needed in Step 1 Table 2.1.2 to bring the final volume in 
Step 3 Table 2.1.2 to 20 µL.
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Table 2.1.1

Reverse Transcriptase Volumes for First Strand cDNA Synthesis Reaction

Total RNA (µg) SuperScript II RT (µL), 200U/µL

      5.0 to 8.0 1.0

      8.1 to 16.0 2.0

    16.1 to 20.0 3.0

The combined volume of RNA DEPC-treated H2O and SuperScript II RT should not 
exceed 11 µL as indicated in Table 2.1.2.

Table 2.1.2

First Strand cDNA Synthesis Components

Reagents  in reaction Volume
Final concentration 

or amount in reaction

1: Primer Hybridization 
Incubate at 70°C for 10 minutes
Quick spin and put on ice

DEPC-treated H2O (variable) 
T7-oligo(dT) primer, 50 µM
RNA (variable)

for final reaction volume of 20 µL
2 µL

5.0 to 20 µg
100 pmol

5.0 to 20 µg

2: Temperature Adjustment
Add to the above tube and mix well 
Incubate at 42°C for 2 minutes

5X First strand cDNA buffer
0.1 M DTT
10 mM dNTP mix

4 µL
2 µL
1 µL

1X
10 mM DTT

500 µM each

3: First Strand Synthesis
Add to the above tube and mix well
Incubate at 42 °C for 1 hour

SuperScript II RT (variable)
(200 U/µL)

See Table 2.1.1 200 U to 1000 U

Total Volume   20 µL

The above incubations have been changed from the SuperScript protocols and are 
done at 42°C.
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Step 2: Second Strand cDNA Synthesis

1. Place First Strand reactions on ice. Centrifuge briefly to bring down condensation on 
sides of tube.

2. Add to the First Strand synthesis tube the reagents listed in the following Second 
Strand Final Reaction Composition Table (Table 2.1.3).

3. Gently tap tube to mix. Then, briefly spin in a microcentrifuge to remove condensation 
and incubate at 16°C for 2 hours in a cooling waterbath.

4. Add 2 µL [10 U] T4 DNA Polymerase.

5. Return to 16°C for 5 minutes.

6. Add 10 µL 0.5 M EDTA.

7. Proceed to cleanup procedure for cDNA, Cleanup of Double-Stranded cDNA on 
page 2.1.15, or store at -20°C for later use. 

Table 2.1.3

 Second Strand Final Reaction Composition 

Component Volume
Final Concentration or 

Amount in Reaction

DEPC-treated water 91 µL

5X Second Strand Reaction Buffer 30 µL 1X

10 mM dNTP mix 3 µL 200 µM each

10 U/µL E. coli DNA Ligase 1 µL 10 U

10 U/µL E. coli DNA Polymerase I 4 µL 40 U

2 U/µL E. coli RNase H 1 µL 2 U 

Final Volume 150 µL
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Synthesis of Double-Stranded cDNA 
From Purified Poly-A mRNA

This protocol is a supplement to instructions provided in the Invitrogen Life Technologies 
SuperScript Choice system. Please note the following before proceeding:

� Read all information and instructions that come with reagents and kits.
� Use the GeneChip T7-Oligo(dT) Promoter Primer Kit2 for priming first strand cDNA 

synthesis in place of the oligo(dT) or random primers provided with the SuperScript 
Choice kit. The GeneChip T7-Oligo(dT) Promoter Primer Kit provides high-quality HPLC-
purified T7-oligo(dT) primer which is essential for 
this reaction.

� It is recommended that each step of this protocol be checked by gel electrophoresis.

T7-oligo(dT) primer

5´ - GGCCAGTGAATTGTAATACGACTCACTATAGGGAGGCGG-(dT)24 - 3´

Step 1: First Strand cDNA Synthesis

Starting material: High-quality poly-A mRNA (0.2 µg to 2.0 µg).

Before starting cDNA synthesis, the correct volumes of DEPC-treated H2O and Reverse 
Transcriptase (RT) must be determined. These volumes will depend on both the 
concentration and total volume of mRNA that is being added to the reaction. For every µg of 
mRNA, you will need to add 1 µL of SuperScript II RT (200 U/µL). For mRNA quantity 
≤ 1 µg, use 1 µL of SuperScript II RT. Synthesis reactions should be done in a 
polypropylene tube (RNase-free).

2. Users who do not purchase the GeneChip T7-Oligo(dT) Promoter Primer Kit may be required to obtain a license under U.S. 
Patent Nos. 5,569,584, 5,716,785, 5,891,636, 6,291,170 and 5,545,522 or to purchase another licensed kit.

When using the GeneChip Sample Cleanup Module for the cDNA and IVT cRNA 
cleanup steps, there is a potential risk of overloading the columns if greater than the 
recommended amount of starting material is used.

Use Table 2.1.4 for variable component calculations. Determine volumes of mRNA 
and SuperScript II RT required, and then calculate the amount of DEPC-treated H2O 
needed in the Primer Hybridization Mix step to bring the final First Strand 
Synthesis reaction volume to 20 µL.
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Step 2: Second Strand cDNA Synthesis

1. Place First Strand reactions on ice. Centrifuge briefly to bring down condensation on 
sides of tube.

2. Add to the First Strand synthesis tube the reagents listed in the following Second 
Strand Final Reaction Composition Table (Table 2.1.5).

3. Gently tap tube to mix. Then, briefly spin in a microcentrifuge to remove condensation 
and incubate at 16°C for 2 hours in a cooling waterbath.

4. Add 2 µL [10 U] T4 DNA Polymerase.

5. Return to 16°C for 5 minutes.

6. Add 10 µL 0.5 M EDTA.

7. Proceed to cleanup procedure for cDNA, Cleanup of Double-Stranded cDNA on 
page 2.1.15, or store at -20°C for later use. 

Table 2.1.4

First Strand cDNA Synthesis Components

Reagents in Reaction Volume

Final Concentration 

or Amount in 

Reaction

1: Primer Hybridization
Incubate at 70°C for 10 minutes
Quick spin and put on ice

DEPC-treated H2O (variable) 
T7-oligo(dT) primer, 50 µM
mRNA (variable)

for final reaction volume of 20 µL
2 µL

0.2 to 2 µg
100 pmol

0.2 to 2 µg

2: Temperature Adjustment
Add to the above tube and mix well
Incubate at 37°C for 2 minutes

5X First Strand cDNA buffer
0.1 M DTT
10 mM dNTP mix

4 µL
2 µL
1 µL

1X
10 mM 

500 µM each

3: First Strand Synthesis
Add to the above tube and mix well 
Incubate at 37°C for 1 hour

SuperScript II RT 
(variable) (200 U/µL)

1 µL per µg mRNA 200 U to 1000 U

Total Volume   20 µL

Table 2.1.5

 Second Strand Final Reaction Composition 

Component Volume
Final Concentration or 

Amount in Reaction

DEPC-treated water 91 µL

5X Second Strand Reaction Buffer 30 µL 1X

10 mM dNTP mix 3 µL 200 µM each

10 U/µL E. coli DNA Ligase 1 µL 10 U

10 U/µL E. coli DNA Polymerase I 4 µL 40 U

2 U/µL E. coli RNase H 1 µL 2 U 

Final Volume 150 µL
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Cleanup of Double-Stranded cDNA

Reagents to be Supplied by User

� Ethanol, 96-100% (v/v)

All other components needed for cleanup of double-stranded cDNA are supplied with the 

GeneChip Sample Cleanup Module.

1. Add 600 µL cDNA Binding Buffer to the 162 µL final double-stranded cDNA synthesis 
preparation (page 2.1.10 or 2.1.13). Mix by vortexing for 3 seconds.

2. Check that the color of the mixture is yellow (similar to cDNA Binding Buffer without 
the cDNA synthesis reaction).

3. Apply 500 µL of the sample to the cDNA Cleanup Spin Column sitting in a 2 mL 
Collection Tube, and centrifuge for 1 minute at ≥ 8,000 x g (≥ 10,000 rpm).

Discard flow-through.

4. Reload the spin column with the remaining mixture (262 µL) and centrifuge as above. 

Discard flow-through and Collection Tube.

5. Transfer spin column into a new 2 mL Collection Tube (supplied). Pipet 750 µL cDNA 
Wash Buffer onto the spin column. Centrifuge for 1 minute at ≥ 8,000 x g 
(≥ 10,000 rpm). 

Discard flow-through.

6. Open the cap of the spin column and centrifuge for 5 minutes at maximum speed 
(≤ 25,000 x g). Discard flow-through and Collection Tube.

Place columns into the centrifuge using every second bucket. Position caps over the 
adjoining bucket so that they are oriented in the opposite direction to the rotation (i.e., 
if the microcentrifuge rotates in a clockwise direction, orient the caps in a counter-
clockwise direction). This avoids damage of the caps. 

Centrifugation with open caps allows complete drying of the membrane.

BEFORE STARTING, please note:

� cDNA Wash Buffer is supplied as a concentrate. Before using for the first time, add 
24 mL of ethanol (96-100%), as indicated on the bottle, to obtain a working solution, 
and checkmark the box on the left-hand side of the bottle label to avoid confusion.

� All steps of the protocol should be performed at room temperature. During the 
procedure, work without interruption.

� If cDNA synthesis was performed in a reaction tube smaller than 1.5 mL, transfer the 
reaction mixture into a 1.5 or 2 mL microfuge tube (not supplied) prior to addition of 
cDNA Binding Buffer.

If the color of the mixture is orange or violet, add 10 µL of 3 M sodium acetate, 
pH 5.0, and mix. The color of the mixture will turn to yellow.

cDNA Wash Buffer is supplied as a concentrate. Ensure that ethanol is added to the 
cDNA Wash Buffer before use (see IMPORTANT note above before starting).
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7. Transfer spin column into a 1.5 mL Collection Tube, and pipet 14 µL of cDNA Elution 
Buffer directly onto the spin column membrane. Incubate for 1 minute at room 
temperature and centrifuge 1 minute at maximum speed (≤ 25,000 x g) to elute.

Ensure that the cDNA Elution Buffer is dispensed directly onto the membrane. The 
average volume of eluate is 12 µL from 14 µL Elution Buffer.

8. An aliquot of the cDNA prepared from isolated poly-A RNA can be analyzed for size 
distribution and yield on a 1% agarose gel. One microliter of double-stranded cDNA 
should be sufficient to detect on an agarose gel stained with ethidium bromide. A 
representative gel is shown in Figure 2.1.1 on page 2.1.22. We do not recommend gel 
analysis for cDNA prepared from total RNA.

9. After cleanup, please proceed to Synthesis of Biotin-Labeled cRNA on page 2.1.17.

We do not recommend RNase treatment of the cDNA prior to the in vitro 
transcription and labeling reaction; the carry-over ribosomal RNA does not seem to 
inhibit the reaction.

Quantifying the amount of double-stranded cDNA by absorbance at 260 nm is not 
recommended. The primer can contribute significantly to the absorbance. 
Subtracting the theoretical contribution of the primer based on the amount added to 
the reaction is not practical.
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Synthesis of Biotin-Labeled cRNA

1. Enzo BioArray HighYield RNA Transcript Labeling Kit3 (Affymetrix, P/N 900182) is 
used for generating labeled cRNA target. Use the following tables to determine the 
amount of cDNA used for each IVT reaction. Done properly, each reaction should 
produce sufficient biotin-labeled target to hybridize to at least three standard format 
GeneChip expression probe arrays in parallel.

The purity and quality of template cDNA is important for high yields of biotin-labeled 
RNA.

Use only RNase-free water, buffers, and pipette tips.

Store all reagents at -20°C, in a freezer that is not self-defrosting. 

Prior to use, centrifuge all reagents briefly to ensure that the components remain at 
the bottom of the tube.

The product should be used only until the expiration date stated on the label.

3. For Research Use Only. This product is manufactured by ENZO LIFE SCIENCES, INC. for distribution by Affymetrix, Inc. for 
research purposes only by the end-user and is not intended for diagnostic or therapeutic use. Purchase does not include a 
license or the right to utilize this product except for research purposes. Purchase does not include the right to distribute or 
sell this product commercially. As distributed by Affymetrix. Inc., this product may be used only in conjunction with and is 
permitted for use only with Affymetrix® GeneChip® probe arrays.

Enzo is a registered trademark of Enzo Biochem, Inc. and BioArray is a trademark of Enzo Biochem, Inc.

This product or the use of this product is covered by one or more claims of Enzo patents including, but not limited to, the 
following: U.S. Patent Nos. 5,328,824; 5,449,767; 5,476,928; 4,711,955 and 4,994,373; EP 0 063 879 B1; EP 0 329 198 B1; 
DK 171 822 B; Canadian Patent Nos. 1,219,824 and 1,309,672; Japanese Patent Nos. 2,131,266; 1,416,584 and other 
patents pending.

Table 2.1.6 

cDNA in IVT (Total RNA)

Total RNA (µg) Volume of cDNA to use in IVT*

5.0 to 8.0         10 µL

8.1 to 16.0         5 µL

16.1 to 20.0         3.3 µL

* assuming 12 µL was eluted from the column, as previously described. 

Table 2.1.7 

cDNA in IVT (Poly-A RNA)

Poly-A RNA (µg) Volume cDNA*

0.2 - 0.5         10 µL

0.6 - 1.0         8 µL

1 - 2         5 µL

* assuming 12 µL was eluted from the column, as previously described.
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2. Add to RNase-free microfuge tubes template cDNA and additions of other reaction 
components in the order indicated in the following table. Keep reactions at room 
temperature while additions are made to avoid precipitation of DTT.

3. Carefully mix the reagents and collect the mixture in the bottom of the tube by brief
(5 second) microcentrifugation.

4. Immediately place the tube in a 37°C water bath. Incubate for 4 to 5 hours, gently 
mixing the contents of the tube every 30-45 minutes during the incubation.

5. Store labeled cRNA at -70°C, or -20°C if not purifying immediately.

Each GeneChip® Sample Cleanup Module contains 30 cDNA cleanup columns and 
30 IVT cRNA cleanup columns. If more than one IVT is carried out from a single cDNA 
sample and is purified on separate IVT cRNA cleanup columns, there will not be 
sufficient IVT cRNA columns in each kit for 30 samples.

Table 2.1.8

IVT cRNA Labeling

Reagent Volume

Template cDNA Variable. Refer to Table 2.1.6 and Table 2.1.7.

Distilled or deionized water Variable (to give a final reaction volume of 40 µL).

10X HY Reaction Buffer (Vial 1) 4 µL

10X Biotin-Labeled Ribonucleotides 
(Vial 2)

4 µL

10X DTT (Vial 3) 4 µL

10X RNase Inhibitor Mix (Vial 4) 4 µL

20X T7 RNA Polymerase (Vial 5) 2 µL

Total Volume 40 µL

Overnight incubation may produce shorter products which is less desirable.
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Cleanup and Quantification of 
Biotin-Labeled cRNA

Reagents to be Supplied by User

� Ethanol, 96-100% (v/v)
� Ethanol, 80% (v/v)

All other components needed for cleanup of biotin-labeled cRNA are supplied with the GeneChip 

Sample Cleanup Module.

Step 1: Cleanup of Biotin-Labeled cRNA

1. Add 60 µL of RNase-free water to the in vitro transcription reaction and mix by 
vortexing for 3 seconds.

2. Add 350 µL IVT cRNA Binding Buffer to the sample and mix by vortexing for 3 
seconds.

3. Add 250 µL ethanol (96-100%) to the lysate, and mix well by pipetting. Do not 
centrifuge.

4. Apply sample (700 µL) to the IVT cRNA Cleanup Spin Column sitting in a 2 mL 
Collection Tube. Centrifuge for 15 seconds at ≥ 8,000 x g (≥ 10,000 rpm). Discard 
flow-through and Collection Tube.

5. Transfer the spin column into a new 2 mL Collection Tube (supplied). Pipet 500 µL 
IVT cRNA Wash Buffer onto the spin column. Centrifuge for 15 seconds at ≥ 8,000 x g 
(≥ 10,000 rpm) to wash. Discard flow-through.

6. Pipet 500 µL 80% (v/v) ethanol onto the spin column and centrifuge for 15 seconds at 
≥ 8,000 x g (≥ 10,000 rpm). Discard flow-through.

BEFORE STARTING please note:

� It is essential to remove unincorporated NTPs, so that the concentration and purity of 
cRNA can be accurately determined by 260 nm absorbance.

� DO NOT extract biotin-labeled RNA with phenol-chloroform. The biotin will cause some 
of the RNA to partition into the organic phase. This will result in low yields.

� Save an aliquot of the unpurified IVT product for analysis by gel electrophoresis.
� IVT cRNA Wash Buffer is supplied as a concentrate. Before using for the first time, add 

20 mL of ethanol (96-100%), as indicated on the bottle, to obtain a working solution, 
and checkmark the box on the left-hand side of the bottle label to avoid confusion.

� IVT cRNA Binding Buffer may form a precipitate upon storage. If necessary, redissolve 
by warming in a water bath at 30°C, and then place the buffer at room temperature.

� All steps of the protocol should be performed at room temperature. During the 
procedure, work without interruption.

IVT cRNA Wash Buffer is supplied as a concentrate. Ensure that ethanol is added to 
the IVT cRNA Wash Buffer before use (see IMPORTANT note above before starting).
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7. Open the cap of the spin column and centrifuge for 5 minutes at maximum speed
(≤ 25,000 x g). Discard flow-through and Collection Tube.

Place columns into the centrifuge using every second bucket. Position caps over the 
adjoining bucket so that they are oriented in the opposite direction to the rotation (i.e., 
if the microcentrifuge rotates in a clockwise direction, orient the caps in a counter-
clockwise direction). This avoids damage of the caps. Centrifugation with open caps 
allows complete drying of the membrane.

8. Transfer spin column into a new 1.5 mL Collection Tube (supplied), and pipet 11 µL of 
RNase-free Water directly onto the spin column membrane. Ensure that the water is 
dispensed directly onto the membrane. Centrifuge 1 minute at maximum speed 
(≤ 25,000 x g) to elute.

9. Pipet 10 µL of RNase-free Water directly onto the spin column membrane. Ensure that 
the water is dispensed directly onto the membrane. Centrifuge 1 minute at maximum 
speed (≤ 25,000 x g) to elute.

For subsequent photometric quantification of the purified cRNA, we recommend 
dilution of the eluate between 1:100 fold and 1:200 fold.

Step 2: Quantification of the cRNA

Use spectrophotometric analysis to determine the cRNA yield. Apply the convention that 
1 absorbance unit at 260 nm equals 40 µg/mL RNA. 

� Check the absorbance at 260 nm and 280 nm to determine sample concentration and 
purity. 

� Maintain the A260/A280 ratio close to 2.0 for pure RNA (ratios between 1.9 and 2.1 are 
acceptable).

For quantification of cRNA when using total RNA as starting material, an adjusted cRNA 
yield must be calculated to reflect carryover of unlabeled total RNA. Using an estimate of 
100% carryover, use the formula below to determine adjusted cRNA yield:

adjusted cRNA yield = RNAm - (total RNAi)(y)

RNAm = amount of cRNA measured after IVT (µg)
total RNAi = starting amount of total RNA (µg)
y = fraction of cDNA reaction used in IVT

Example: Starting with 10 µg total RNA, 50% of the cDNA reaction is added to the IVT, 
giving a yield of 50 µg cRNA. Therefore, adjusted cRNA yield = 50 µg cRNA - (10 µg total 
RNA) (0.5 cDNA reaction) = 45.0 µg.

Use adjusted yield in Eukaryotic Target Hybridization on page 2.3.3.

The minimum concentration for purified cRNA is 0.6 µg/µL before starting the 
following fragmentation reaction in "Fragmenting the cRNA for Target 
Preparation" on page 2.1.21.

Please refer to Table 2.3.1 on page 2.3.7 for the amount of cRNA required for one 
array hybridization experiment. The amount varies depending on the array format. 
Please refer to a specific probe array package insert for information on the array 
format.
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Step 3: Checking Unfragmented Samples by Gel Electrophoresis

Gel electrophoresis of the IVT product is done to estimate the yield and size distribution of 
labeled transcripts. Parallel gel runs of unpurified and purified IVT product can help 
determine the extent of a loss of sample during the cleanup process. 

� Run 1% of each sample on a 1% agarose gel.
� Mix RNA (samples or markers) with loading dye and heat to 65°C for 5 minutes before 

loading on the gel. 
� Ethidium bromide can be used to visualize the RNA in the gel.

Alternatively, gels can be stained with SYBR Green II at a 1:10,000 dilution in 1X TBE 
buffer. SYBR Green II stains single-stranded RNA with greater sensitivity than ethidium 
bromide, but it requires a special photographic filter available from Molecular Probes to 
photograph stained bands.

� As an option, run a denaturing gel to obtain a more accurate estimation of the RNA size 
distribution. Please refer to Figure 2.1.1 for the typical size distribution of unfragmented 
cRNA.

Fragmenting the cRNA 
for Target Preparation

5X Fragmentation Buffer is supplied with the GeneChip Sample Cleanup Module.

Fragmentation of cRNA target before hybridization onto GeneChip probe arrays has been 
shown to be critical in obtaining optimal assay sensitivity.

Affymetrix recommends that the cRNA used in the fragmentation procedure be sufficiently 
concentrated to maintain a small volume during the procedure. This will minimize the 
amount of magnesium in the final hybridization cocktail. The cRNA must be at a minimum 
concentration of 0.6 µg/µL. Fragment an appropriate amount of cRNA for hybridization 
cocktail and gel analysis (see Section 2, Chapter 3, Table 2.3.1).

1. Add 2 µL of 5X Fragmentation Buffer for every 8 µL of RNA plus H2O. The 
fragmentation buffer has been optimized to break down full-length cRNA to 35 to 200 
base fragments by metal-induced hydrolysis.

The final concentration of RNA in the fragmentation mix can range from 0.5 µg/µL to 
2 µg/µL. The following table shows an example of a fragmentation mix for a 20 µg 
cRNA sample at a final concentration of 0.5 µg/µL. 

For fragmentation, use adjusted cRNA concentration, as described in Step 2: 
Quantification of the cRNA on page 2.1.20.

Example for 0.5 µg/µL final concentration:

2. Incubate at 94°C for 35 minutes. Put on ice following the incubation. 

Table 2.1.9 

Example of Fragmentation Reaction

Component Volume

    20 µg cRNA 1 to 21 µL

    5X Fragmentation
    Buffer

8 µL

    RNase-free water to 40 µL
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3. Save an aliquot for gel analysis.

At least 1 µg fragmented cRNA is needed if using ethidium bromide for staining the 
gel. Less RNA can be used with SYBR Green II staining. See Step 3: Checking 
Unfragmented Samples by Gel Electrophoresis on page 2.1.21, for information 
regarding gel electrophoresis. The standard fragmentation procedure should produce a 
distribution of RNA fragment sizes from approximately 35 to 200 bases. An example 
of a gel with cRNA samples before and after fragmentation is shown below.

4. Store undiluted, fragmented sample RNA at -20°C until ready to perform the 
hybridization, as described in Section 2, Chapter 3.

Figure 2.1.1    

Monitoring of target preparation by agarose gel electrophoresis
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Alternative Protocol for Cleanup of 
Double-Stranded cDNA

Step 1: Phase Lock Gels (PLG)-Phenol/Chloroform Extraction

Phase Lock Gels (PLG) form an inert, sealed barrier between the aqueous and organic 
phases of phenol-chloroform extractions. The solid barrier allows more complete recovery 
of the sample (aqueous phase) and minimizes interface contamination of the sample. PLG’s 
are sold as premeasured aliquots in 1.5 mL tubes to which sample and phenol chloroform 
are directly added.

1. Pellet the Phase Lock Gel (1.5 mL tube with PLG I - heavy) in a microcentrifuge at 
12,000 x g for 20 to 30 seconds.

2. Add 162 µL (equal volume) of (25:24:1) Phenol:chloroform:isoamyl alcohol (saturated 
with 10 mM Tris-HCl pH 8.0, 1 mM EDTA) to the final cDNA synthesis preparation 
(162 µL) to a final volume of 324 µL. Vortex briefly.

(See Reagents and Materials Required on page 2.1.5 for ordering information for 
phenol:chloroform:isoamyl alcohol.)

3. Transfer the entire cDNA-phenol/chloroform mixture to the PLG tube.

4. DO NOT VORTEX. PLG will now become part of the suspension. Microcentrifuge at 
full speed (12,000 x g) for 2 minutes.

5. Transfer the aqueous upper phase to a fresh 1.5 mL tube.

Step 2: Ethanol Precipitation

Please refer to Precipitation of RNA on page 2.1.9 for information on the use of carriers 
during ethanol precipitation.

1. Add 0.5 volumes of 7.5 M NH4OAc and 2.5 volumes of absolute ethanol (stored at 
-20°C) to the sample and vortex.

2. Immediately centrifuge at 12,000 x g in a microcentrifuge at room temperature for 
20 minutes.

3. Remove supernatant. Wash pellet with 0.5 mL of 80% ethanol (stored at -20°C).

4. Centrifuge at 12,000 x g at room temperature for 5 minutes.

5. Remove the 80% ethanol very carefully; the pellet may be loose. Repeat the 80% 
ethanol wash one additional time.

The following procedure may be followed as an alternative to using the cDNA 
cleanup columns in the GeneChip Sample Cleanup Module. Global concordance on 
array results obtained from using the two protocols has been established. However, 
Affymetrix encourages customers to evaluate their unique samples carefully before 
comparing results from the two cleanup protocols directly.

A standard phenol/chloroform extraction can be performed as an alternative to the 
PLG procedure.

Store phenol:chloroform:isoamyl alcohol at 4°C. Dispose of solution when it turns 
pink.
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6. Air dry the pellet. Check pellet for dryness before proceeding.

7. Resuspend dried pellet in a small volume of RNase-free water. We recommend 
resuspending in 12 µL.

Alternative Protocol for Preparing 
5X Fragmentation Buffer

5X RNA Fragmentation Buffer 
(200 mM Tris-acetate, pH 8.2, 500 mM KOAc, 150 mM MgOAc)

The fragmentation buffer is made with RNase-free reagents. Tris-containing solutions 
should not be treated with DEPC; however, once H2O has been DEPC-treated and 
autoclaved it can be used for making the Tris solution.

1. Combine the following components to a total volume of 20 mL.

� 4.0 mL 1 M Tris acetate pH 8.1 (Trizma Base, pH adjusted with glacial acetic acid)

� 0.64 g MgOAc

� 0.98 g KOAc

� DEPC-treated H2O to 20 mL

Final pH without adjustment should be 8.2.

2. Mix thoroughly and filter through a 0.2 µm vacuum filter unit. This reagent should be 
aliquotted and stored at room temperature.
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Controls for Eukaryotic Arrays

Reagents and Materials Required .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 2.2.5

Hybridization Control Kit .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 2.2.7

Poly-A Spike Controls   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 2.2.7

This Chapter Contains:

� General guidelines for producing controls for eukaryotic arrays.

After completing the procedures described in this chapter, the control transcripts are 
combined in variable concentrations before adding to the target hybridization mix as 
explained in Section 2, Chapter 3.
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Reagents and Materials Required 

The following reagents and materials are recommendations and have been tested and 
evaluated by Affymetrix scientists. For supplier phone numbers in the U.S. and Europe, 
please refer to the Supplier and Reagent Reference List, Appendix A, of this manual. 
Information and part numbers listed are based on U.S. catalog information. Additional 
reagents needed for the complete analysis are listed in the appropriate chapters. 
Appendix A contains a master list of all reagents used in this manual.

GeneChip Eukaryotic Hybridization Control Kit (Complete Kit)
� Affymetrix, P/N 900299 (30 reactions) or P/N 900362 (150 reactions)

Poly-A Spike Controls
� pGIBS-lys ATCC 87482

� pGIBS-phe ATCC 87483

� pGIBS-thr ATCC 87484

� pGIBS-trp ATCC 87485

� pGIBS-dap ATCC 87486
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Hybridization Control Kit

Each commercially available eukaryotic probe array contains probe sets for several 
prokaryotic genes as controls. These probe sets are readily identified by the AFFX prefix in 
the probe set name. The .chp data for these control probe sets can be examined in the 
Summary Report File (.rpt).

Control Oligo B2

Control Oligo B2 hybridizes to features along the outer edge of all expression arrays and to 
the checkerboard pattern in each corner. These predefined patterns provide signals for the 
Microarray Suite software to perform automatic grid alignment during image analysis. 
They can also be used to align the grid manually. The fluorescence intensities for Control 
Oligo B2 are not used for analyzing data.

A 60X stock of the B2 oligo is provided as part of the GeneChip Eukaryotic Hybridization 
Control Kit (P/N 900299 or 900362, for 30 or 150 reactions, respectively), or can be 
purchased alone (P/N 900301). Please refer to the instructions in Section 2, Chapter 3 for 
detailed information on including the B2 oligo in preparing the hybridization cocktail.

Biotinylated Hybridization Controls: bioB, bioC, bioD, and cre

BioB, bioC, and bioD are genes of the biotin synthesis pathway from the bacteria E. coli, 
and cre is the recombinase gene from P1 bacteriophage. A ready-prepared mixture of these 
biotinylated controls at staggered concentrations can be added with labeled eukaryotic 
cRNA samples to hybridize onto GeneChip probe arrays. Signal intensities obtained on 
these genes provide information on how well the hybridization, washing and staining 
procedures have performed. 

Affymetrix provides a kit that contains a 20X pre-mixed control reagents (P/N 900299 or 
900362) and the final concentrations in the hybridization cocktail are 1.5 pM, 5 pM, 25 pM 
and 100 pM for the four transcripts bioB, bioC, bioD, and cre, respectively.

Poly-A Spike Controls

Five poly-A-tailed control clones encoding B. subtilis genes (dap, thr, trp, phe, lys) are 
cloned into pBluescript as an Xho I to Not I insert, 5´ to 3´, respectively. 

Poly-A-tailed constructs (dap, thr, trp, phe, lys)

These clones can be cut with different restriction enzymes to produce template DNA for 
either sense strand RNA synthesis or antisense RNA synthesis. The antisense control RNA 
for each B. subtilis gene is synthesized from linearized plasmid using T7 RNA polymerase 
with biotinylated nucleotides. The sense RNA for each B. subtilis gene is synthesized from 
linearized plasmid using T3 RNA polymerase with unlabeled nucleotides. For detailed 
preparation of sense RNA controls, please refer to Section 3, Chapter 2.

T3 5’

Xho I Not I

AAAAA 3’ T7
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The antisense strand B. subtilis RNA controls are used as described above for bioB, bioC, 
and bioD genes. The sense strand RNA controls can be spiked into samples during mRNA 
preparation to monitor the efficiency of target preparation, hybridization, wash, and stain.

Bacteria containing these recombinant plasmids can be obtained from the American Type 
Culture Collection (ATCC). See Reagents and Materials Required on page 2.2.5 for details.
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Eukaryotic Target Hybridization

Reagents and Materials Required .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 2.3.5

Reagent Preparation .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 2.3.6

Eukaryotic Target Hybridization  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 2.3.7

This Chapter Contains:

� Detailed steps for preparing the eukaryotic hybridization mix containing labeled target
and control cRNA.

� Instructions for hybridizing the target mix to a eukaryotic GeneChip probe array.

After completing the procedures described in this chapter, the hybridized probe array is 
ready for washing, staining, and scanning as detailed in Section 2, Chapter 4.
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Reagents and Materials Required

The following reagents and materials are recommendations and have been tested and 
evaluated by Affymetrix scientists. For supplier phone numbers in the U.S. and Europe, 
please refer to the Supplier and Reagent Reference List, Appendix A, of this manual. 
Information and part numbers listed are based on U.S. catalog information. Additional 
reagents needed for the complete analysis are listed in the appropriate chapters. 
Appendix A contains a master list of all reagents used in this manual.

� Water, Molecular Biology Grade, BioWhittaker Molecular Applications / Cambrex, P/N 
51200

� Acetylated Bovine Serum Albumin (BSA) solution (50 mg/mL), Invitrogen Life 
Technologies, P/N 15561-020

� Herring Sperm DNA, Promega Corporation, P/N D1811

� Micropure Separator, Millipore, P/N 42512 (optional)

� GeneChip Eukaryotic Hybridization Control Kit, Affymetrix, P/N 900299
(contains Control cRNA and Control Oligo B2)

� Control Oligo B2, 3 nM, Affymetrix, P/N 900301 (can be ordered separately)

� 5 M NaCl, RNase-free, DNase-free, Ambion, P/N 9760G

� MES Free Acid Monohydrate SigmaUltra, Sigma-Aldrich, P/N M5287 

� MES Sodium Salt, Sigma-Aldrich, P/N M5057

� EDTA Disodium Salt, 0.5 M solution (100 mL), Sigma-Aldrich, P/N E7889

Miscellaneous Reagents
� Tough Spots, Label Dots, USA Scientific, P/N 9185 (optional)

� Surfact-Amps 20 (Tween-20), 10%, Pierce Chemical, P/N 28320

Miscellaneous Supplies
� Hybridization Oven 640, Affymetrix, P/N 800139

� Sterile, RNase-free, microcentrifuge tubes, 1.5 mL, USA Scientific,
P/N 1415-2600 (or equivalent)

� Micropipettors, (P-2, P-20, P-200, P-1000), Rainin Pipetman or equivalent

� Sterile-barrier pipette tips and non-barrier pipette tips

� Heatblock



SECTION 2   Eukaryotic Sample and Array Processing

2.3.6

Reagent Preparation

12X MES Stock

(1.22 M MES, 0.89 M [Na+])

For 1000 mL:

70.4 g MES-free acid monohydrate

193.3 g MES Sodium Salt

800 mL of Molecular Biology Grade water

Mix and adjust volume to 1000 mL.

The pH should be between 6.5 and 6.7. Filter through a 0.2 µm filter.

2X Hybridization Buffer

(Final 1X concentration is 100 mM MES, 1 M [Na+], 20 mM EDTA, 0.01% Tween 20)

For 50 mL:

8.3 mL of 12X MES Stock

17.7 mL of 5 M NaCl

4.0 mL of 0.5 M EDTA 

0.1 mL of 10% Tween 20

19.9 mL of water

Store at 2°C to 8°C, and shield from light

 Do not autoclave. Store at 2°C to 8°C, and shield from light. 

Discard solution if yellow.
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Eukaryotic Target Hybridization

Please refer to the table below for the necessary amount of cRNA for appropriate probe 
array format. These recipes take into account that it is necessary to make extra hybridization 
cocktail due to a small loss of volume (10-20 µL) during each hybridization.

1. Mix the following for each target, scaling up volumes for hybridization to multiple 
probe arrays.

2. Equilibrate probe array to room temperature immediately before use.

3. Heat the hybridization cocktail to 99°C for 5 minutes in a heat block.

4. Meanwhile, wet the array by filling it through one of the septa (see Figure 2.3.1 for 
location of the probe array septa) with appropriate volume 1X Hybridization Buffer 
using a micropipettor and appropriate tips (Table 2.3.2).

Table 2.3.1

Hybridization Cocktail for Single Probe Array*

Component
Micro/Mini 

Array

Midi 

Array

Standard 

Array

Final 

Concentration 

Fragmented cRNA ** 5 µg 10 µg 15 µg 0.05 µg/µL

Control Oligonucleotide B2 
(3 nM)

1.7 µL 3.3 µL 5 µL 50 pM

20X Eukaryotic Hybridization 
Controls (bioB, bioC, bioD, cre)

5 µL 10 µL 15 µL 1.5, 5, 25 and 
100 pM respectively

Herring Sperm DNA
(10 mg/mL)

1 µL 2µL 3 µL 0.1 mg/mL

Acetylated BSA 
(50 mg/mL)

1 µL 2 µL 3 µL 0.5 mg/mL

2X Hybridization Buffer 50 µL 100 µL 150 µL 1X

H2O  to final volume 
of 100 µL

to final volume 
of 200 µL

 to final volume of 
300 µL

Final volume 100 µL 200 µL 300 µL

*Please refer to specific probe array package insert for information on array format.

**Please see Section 2, Chapter 1, page 2.1.20 for amount of adjusted fragmented cRNA to use when starting 
from total RNA.

It is imperative that frozen stocks of 20X GeneChip Eukaryotic Hybridization Control 
be heated to 65°C for 5 minutes to completely resuspend the cRNA before 
aliquotting.

It is important to allow the arrays to equilibrate to room temperature completely. 
Specifically, if the rubber septa are not equilibrated to room temperature, they may 
be prone to cracking which can lead to leaks.

It is necessary to use two pipette tips when filling the probe array cartridge: one for 
filling and the second to allow venting of air from the hybridization chamber. After 
the addition of hybridization cocktails to the array, the septa may be covered with 
Tough Spots to prevent evaporation.
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5. Incubate the probe array filled with 1X Hybridization Buffer at 45°C for 10 minutes 
with rotation.

6. Transfer the hybridization cocktail that has been heated at 99°C, in step 3, to a 45°C 
heat block for 5 minutes.

7. Spin hybridization cocktail(s) at maximum speed in a microcentrifuge for 5 minutes to 
remove any insoluble material from the hybridization mixture.

8. Remove the buffer solution from the probe array cartridge and fill with appropriate 
volume (Table 2.3.2 on page 2.3.8) of the clarified hybridization cocktail avoiding any 
insoluble matter in the volume at the bottom of the tube.

9. Place probe array in rotisserie box in 45°C oven.

Avoid stress to rotisserie motor; load probe arrays in a balanced configuration around 
rotisserie axis. Rotate at 60 rpm.

10. Hybridize for 16 hours.

During the latter part of the 16-hour hybridization, proceed to Section 2, Chapter 4 to 
prepare reagents required immediately after completion of hybridization.

Table 2.3.2

Probe Array Cartridge Volumes

Array Hybridization Volume Total Fill Volume

Standard 200 µL 250 µL

Midi 130 µL 160 µL

Mini 80 µL 100 µL

Micro 80 µL 100 µL

Figure 2.3.1      

GeneChip® Probe Array
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Eukaryotic Arrays: 
Washing, Staining, and Scanning
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Step 3: Preparing the Fluidics Station.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 2.4.8

Probe Array Wash and Stain   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 2.4.9

Washing and Staining Procedure 1: Single Stain for Eukaryotic Targets   .  .  .  .  .  . 2.4.9

Washing and Staining Procedure 2: Antibody Amplification for 
Eukaryotic Targets   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  2.4.12
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Shutting Down the Fluidics Station .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  2.4.16
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This Chapter Contains:

� Instructions for using the Fluidics Station 400 to automate the washing and staining of 
eukaryotic GeneChip® expression probe arrays.

� Instructions for scanning probe arrays using the GeneArray® Scanner.

After completing the procedures described in this chapter, the scanned probe array image 
(.dat file) is ready for analysis, as explained in the enclosed GeneChip Expression Analysis: 
Data Analysis Fundamentals booklet (P/N 701190).
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Reagents and Materials Required

The following reagents and materials are recommendations and have been tested and 
evaluated by Affymetrix scientists. For supplier phone numbers in the U.S. and Europe, 
please refer to the Supplier and Reagent Reference List, Appendix A, of this manual. 
Information and part numbers listed are based on U.S. catalog information. Additional 
reagents needed for the complete analysis are listed in the appropriate chapters. 
Appendix A contains a master list of all reagents used in this manual.

� Water, Molecular Biology Grade, BioWhittaker Molecular Applications / Cambrex, 
P/N 51200

� Distilled water, Invitrogen Life Technologies, P/N 15230147

� Acetylated Bovine Serum Albumin (BSA) solution (50 mg/mL), Invitrogen Life 
Technologies, P/N 15561-020

� R-Phycoerythrin Streptavidin, Molecular Probes, P/N S-866

� 5 M NaCl, RNase-free, DNase-free, Ambion, P/N 9760G

� PBS, pH 7.2, Invitrogen Life Technologies, P/N 20012-027

� 20X SSPE (3 M NaCl, 0.2 M NaH2PO4, 0.02 M EDTA), BioWhittaker Molecular 
Applications / Cambrex, P/N 51214

� Goat IgG, Reagent Grade, Sigma-Aldrich, P/N I 5256

� Anti-streptavidin antibody (goat), biotinylated, Vector Laboratories, P/N BA-0500

� 10% surfact-Amps20 (Tween-20), Pierce Chemical, P/N 28320

� Bleach (5.25% Sodium Hypochlorite), VWR Scientific, P/N 21899-504 (or equivalent)

Miscellaneous Supplies
� Sterile, RNase-free, microcentrifuge tubes, 1.5 mL, USA Scientific, P/N 1415-2600 

(or equivalent)

� Micropipettors, (P-2, P-20, P-200, P-1000), Rainin Pipetman (or equivalent)

� Sterile-barrier pipette tips and non-barrier pipette tips

� Tygon Tubing, 0.04″ inner diameter, Cole-Palmer, P/N H-06418-04

� Water, Molecular Biology Grade, BioWhittaker Molecular Applications / Cambrex, 
P/N 51200
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Reagent Preparation

Wash A: Non-Stringent Wash Buffer

(6X SSPE, 0.01% Tween 20)

For 1000 mL:

300 mL of 20X SSPE

1.0 mL of 10% Tween-20

699 mL of water

Filter through a 0.2 µm filter

Wash B: Stringent Wash Buffer

(100 mM MES, 0.1 M [Na+], 0.01% Tween 20)

For 1000 mL:

83.3 mL of 12X MES Stock Buffer (see Section 2, Chapter 3 for reagent preparation)

5.2 mL of 5 M NaCl

1.0 mL of 10% Tween 20

910.5 mL of water 

Filter through a 0.2 µm filter

Store at 2°C to 8°C and shield from light

2X Stain Buffer

(Final 1X concentration: 100 mM MES, 1 M [Na+], 0.05% Tween 20)

For 250 mL:

41.7 mL 12X MES Stock Buffer (see Section 2, Chapter 3 for reagent preparation)

92.5 mL 5 M NaCl

2.5 mL 10% Tween 20

113.3 mL water

Filter through a 0.2 µm filter

Store at 2°C to 8°C and shield from light

10 mg/mL Goat IgG Stock

Resuspend 50 mg in 5 mL 150 mM NaCl

Store at 4°C

If a larger volume of the 10 mg/mL IgG stock is prepared, aliquot and store at -20°C 
until use. After the solution has been thawed it should be stored at 4°C. Avoid 
additional freezing and thawing.
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Experiment and Fluidics Station Setup

Step 1:  Defining File Locations

Before working with Microarray Suite it is important to define where the program stores 
and looks for files.

1. Launch Microarray Suite from the workstation and select Tools → Defaults → File 
Locations from the menu bar.

2. The File Locations window displays the locations of the following files:

� Probe Information (library files, mask files)

� Fluidics Protocols (fluidics station scripts)

� Experiment Data (.exp, .dat, .cel, and .chp files are all saved to location selected 
here)

3. Verify that all three file locations are set correctly and click OK.

Contact Affymetrix Technical Support if you have any questions regarding this 
procedure.

Step 2:  Entering Experiment Information

To wash, stain and scan a probe array, an experiment must first be defined in Microarray 
Suite.

1. Select Run → Experiment Info from the menu bar. Alternatively, click the New 
Experiment icon on the tool bar.

⇒ The Experiment Information dialog box appears allowing the experiment name to 
be defined along with several other parameters, such as probe array type, sample 
description, and comments.

2. Type in the Experiment Name. 

3. In the Probe Array Type box, click the arrow and select the probe array type from the 
drop-down list.

Experiment name and probe array type are required. Complete as much of the other 
information as desired. The protocol information at the bottom of the dialog box is 
exported to the experiment information dialog box after the hybridization and scan are 
completed.

4. Save the experiment by selecting Save.

The name of the experiment is used by Microarray Suite to access the probe array type 
and data for the sample while it is being processed. Data files generated for the sample 
are automatically labeled to correspond to the experiment name. Microarray Suite 
automatically fills in the Protocol section of this dialog box with information on array 
processing from the fluidics station.

5. Close the Experiment Information dialog box.
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Step 3:  Preparing the Fluidics Station

The Fluidics Station 400 is used to wash and stain the probe arrays. It is operated using 
Microarray Suite.

Setting Up the Fluidics Station

1. Turn on the Fluidics Station using the toggle switch on the lower left side of the 
machine.

2. Select Run → Fluidics from the menu bar. 

⇒ The Fluidics Station dialog box appears with a drop-down list for selecting the 
experiment name for each of the fluidics station modules. A second drop-down list 
is accessed for choosing the Protocol for each of the four fluidics station modules.

Priming the Fluidics Station

Priming ensures that the lines of the fluidics station are filled with the appropriate buffers 
and the fluidics station is ready for running fluidics station protocols.

Priming should be done:

� when the fluidics station is first started.

� when wash solutions are changed.

� before washing, if a shutdown has been performed.

� if the LCD window instructs the user to prime.

1. To prime the fluidics station, select Protocol in the Fluidics Station dialog box.

2. Choose Prime for the respective modules in the Protocol drop-down list.

3. Change the intake buffer reservoir A to Non-Stringent Wash Buffer and intake buffer 
reservoir B to Stringent Wash Buffer.

4. Click Run for each module to begin priming.

Refer to the Fluidics Station 400 User’s Guide for instructions on connecting and 
addressing multiple fluidics stations.
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Probe Array Wash and Stain

Affymetrix offers two staining protocols: 1) the single stain protocol for eukaryotic targets 
(page 4.9), and 2) a signal amplification protocol for eukaryotic targets (page 4.12). Please 
use the Antibody Amplification Washing and Staining Protocol for all arrays with probe 
cells of 24 µm or smaller.

1. After 16 hours of hybridization, remove the hybridization cocktail from the probe array 
and set it aside in a microcentrifuge tube. Store on ice during the procedure or at -80°C 
for long-term storage.

2. Fill the probe array completely with the appropriate volume of Non-Stringent Wash 
Buffer, as given in Table 2.3.2 on page 2.3.8.

Washing and Staining Procedure 1: Single Stain for Eukaryotic Targets

Preparing the SAPE Stain Solution

Streptavidin Phycoerythrin (SAPE) should be stored in the dark at 4°C, either foil-wrapped 
or kept in an amber tube. Remove SAPE from refrigerator and tap the tube to mix well 
before preparing stain solution. Do not freeze SAPE. Always prepare the SAPE stain 
solution immediately before use.

For each probe array to be stained, combine the following components in a microcentrifuge 
tube:

If necessary, at this point, the probe array can be stored at 4°C for up to 3 hours 
before proceeding with washing and staining. Equilibrate the probe array to room 
temperature before washing and staining.

Volumes needed will be the same for all fluidics protocols.  This procedure takes 
approximately 75 minutes to complete.

Table 2.4.1 

SAPE Solution Mix

Components Volume Final Concentration

2X MES Stain Buffer 300.0 µL 1X

50 mg/mL acetylated BSA 24.0 µL 2 mg/mL

1 mg/mL Streptavidin Phycoerythrin (SAPE) 6.0 µL 10 µg/mL

DI H20 270.0 µL —

Total 600 µL
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Washing and Staining the Probe Array

1. In the Fluidics Station dialog box on the workstation, select the correct experiment 
name in the drop-down Experiment list. The probe array type will appear 
automatically. 

2. In the Protocol drop-down list, select the specific single stain protocol to control the 
washing and staining of the probe array format being used: Table 2.4.2.

3. Choose Run in the Fluidics Station dialog box to begin the washing and staining. 
Follow the instructions on the LCD window on the fluidics station.

If you are unfamiliar with inserting and removing probe arrays from the fluidics station 
modules, please refer to the Fluidics Station 400 User’s Guide, Fluidics Station 400 
Video In-Service CD (P/N 900374), or Quick Reference Card (P/N 08-0072).

4. Insert the appropriate probe array into the designated module of the fluidics station 
while the probe array lever is in the EJECT position. When finished, verify that the 
probe array lever is returned to the ENGAGE position.

5. Remove any microcentrifuge tube remaining in the sample holder of the fluidics station 
module(s) being used.

6. Place the microcentrifuge tube containing the SAPE stain solution into the sample 
holder, verifying that the metal sampling needle is in the tube with its tip near the 
bottom.

⇒ The Fluidics Station dialog box and the LCD window display the status of the 
washing and staining as they progress. When the wash is complete, the LCD 
window displays the message EJECT CARTRIDGE.

7. Remove microcentrifuge tube containing stain and replace with an empty 
microcentrifuge tube.

8. Remove the probe arrays from the fluidics station modules by first moving the probe 
array holder lever to the EJECT position. 

9. Check the probe array window for large bubbles or air pockets. 

Table 2.4.2 

Fluidics Protocols - Single Stain for Eukaryotic Targets

Standard Format

EukGE-WS1
Mini Format

Mini_euk1

Post Hyb 
Wash #1

10 cycles of 2 mixes/cycle with 
Wash Buffer A at 25°C

 10 cycles of 2 mixes/cycle with 
Wash Buffer A at 25°C

Post Hyb 
Wash #2

4 cycles of 15 mixes/cycle with 
Wash Buffer B at 50°C

8 cycles of 15 mixes/cycle with 
Wash Buffer B at 50°C

Stain Stain the probe array for 30 minutes in 
SAPE solution at 25°C

Stain the probe array for 10 minutes in 
SAPE solution at 25°C

Final Wash
10 cycles of 4 mixes/cycle with 
Wash Buffer A at 25°C. The holding 
temperature is 25°C

10 cycles of 4 mixes/cycle with 
Wash Buffer A at 30°C. The holding 
temperature is 25°C

• Wash Buffer A = non-stringent wash buffer
• Wash Buffer B = stringent wash buffer
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� If bubbles are present, proceed to Table 2.4.3.

� If the probe array has no large bubbles, it is ready to scan on the GeneArray Scanner. 
ENGAGE wash block and proceed to Probe Array Scan on page 2.4.15. 

If you do not scan the arrays right away, keep the probe arrays at 4°C and in the dark 
until ready for scanning.

If there are no more samples to hybridize, shut down the fluidics station following the 
procedure outlined in the section, Shutting Down the Fluidics Station on page 2.4.16.

For proper cleaning and maintenance of the fluidics station including the bleach 
protocol, refer to Section 4, Fluidics Station Maintenance Procedures.

Table 2.4.3

If Bubbles are Present

Return the probe array to the probe array holder. Latch the probe array holder by gently 
pushing it up until a light click is heard. Engage the wash block by firmly pushing up on the 
probe array lever to the ENGAGE position.
The fluidics station will drain the probe array and then fill it with a fresh volume of the last 
wash buffer used. When it is finished, if the LCD window displays EJECT CARTRIDGE 
again, remove the probe array and inspect it again for bubbles. If no bubbles are present, it is 
ready to scan. Proceed to Probe Array Scan on page 2.4.15.
If several attempts to fill the probe array without bubbles are unsuccessful, the array should 
be filled with Wash A (non-stringent buffer) manually, using a micropipette. Excessive 
washing will result in a loss of signal intensity. 
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Washing and Staining Procedure 2: Antibody Amplification for Eukaryotic Targets

This protocol is recommended for use with probe arrays with probe cells of 24 µm or 
smaller. This procedure takes approximately 90 minutes to complete.

Preparing the Staining Reagents

Prepare the following reagents. Volumes given are sufficient for one probe array.

SAPE Stain Solution

Streptavidin Phycoerythrin (SAPE) should be stored in the dark at 4°C, either foil-wrapped 
or kept in an amber tube. Remove SAPE from refrigerator and tap the tube to mix well 
before preparing stain solution. Do not freeze concentrated SAPE or diluted SAPE stain 
solution. Always prepare the SAPE stain solution immediately before use.

Mix well and divide into two aliquots of 600 µL each to be used for stains 1 and 3, 
respectively.

Antibody Solution

Table 2.4.4 

SAPE Solution Mix

Components Volume Final Concentration

2X MES Stain Buffer 600.0 µL 1X

50 mg/mL acetylated BSA 48.0 µL 2 mg/mL

1 mg/mL Streptavidin Phycoerythrin (SAPE) 12.0 µL 10 µg/mL

DI H20 540.0 µL —

Total 1200 µL

Table 2.4.5 

Antibody Solution Mix

Components Volume Final Concentration

2X MES Stain Buffer 300.0 µL 1X

50 mg/mL acetylated BSA 24.0 µL 2 mg/mL

10 mg/mL Normal Goat IgG 6.0 µL 0.1 mg/mL

0.5 mg/mL biotinylated antibody 3.6 µL 3 µg/mL

DI H20 266.4 µL —

Total 600 µL
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Washing and Staining the Probe Array

1. In the Fluidics Station dialog box on the workstation, select the correct experiment 
name from the drop-down Experiment list. 

⇒ The Probe Array Type appears automatically.

2. In the Protocol drop-down list, select the appropriate antibody amplification protocol 
to control the washing and staining of the probe array format being used.

3. Choose Run in the Fluidics Station dialog box to begin the washing and staining. 
Follow the instructions in the LCD window on the fluidics station.

If you are unfamiliar with inserting and removing probe arrays from the fluidics station 
modules, please refer to the Fluidics Station 400 User’s Guide, Fluidics Station 400 
Video In-Service CD (P/N 900374), or Quick Reference Card (P/N 08-0072).

4. Insert the appropriate probe array into the designated module of the fluidics station 
while the probe array lever is in the EJECT position. When finished, verify that the 
probe array lever is returned to the ENGAGE position.

5. Remove any microcentrifuge tube remaining in the sample holder of the fluidics station 
module(s) being used.

Table 2.4.6 

Fluidics Protocols - Antibody Amplification for Eukaryotic Targets

Standard Format

EukGE-WS2
Midi Format

Midi_euk2
Micro / Mini Format

Micro_1v1 / Mini_euk2

Post Hyb 
Wash #1

10 cycles of 2 mixes/cycle with 
Wash Buffer A at 25°C

10 cycles of 2 mixes/cycle with 
Wash Buffer A at 30°C

 10 cycles of 2 mixes/cycle with 
Wash Buffer A at 25°C

Post Hyb 
Wash #2

4 cycles of 15 mixes/cycle with 
Wash Buffer B at 50°C

6 cycles of 15 mixes/cycle with 
Wash Buffer B at 50°C

8 cycles of 15 mixes/cycle with 
Wash Buffer B at 50°C

Stain Stain the probe array for 10 minutes 
in SAPE solution at 25°C

Stain the probe array for 5 minutes 
in SAPE solution at 35°C

Stain the probe array for 10 minutes 
in SAPE solution at 25°C

Post Stain 
Wash

10 cycles of 4 mixes/cycle with 
Wash Buffer A at 25°C

10 cycles of 4 mixes/cycle with 
Wash Buffer A at 30°C

10 cycles of 4 mixes/cycle with 
Wash Buffer A at 30°C

2nd Stain Stain the probe array for 10 minutes 
in antibody solution at 25°C

Stain the probe array for 5 minutes 
in antibody solution at 35°C

Stain the probe array for 10 minutes 
in antibody solution at 25°C

3rd Stain Stain the probe array for 10 minutes 
in SAPE solution at 25°C

Stain the probe array for 5 minutes 
in SAPE solution at 35°C

Stain the probe array for 10 minutes 
in SAPE solution at 25°C

Final Wash
15 cycles of 4 mixes/cycle with 
Wash Buffer A at 30°C
The holding temperature is 25°C

15 cycles of 4 mixes/cycle with 
Wash Buffer A at 35°C
The holding temperature is 25°C

15 cycles of 4 mixes/cycle with 
Wash Buffer A at 35°C
The holding temperature is 25°C

• Wash Buffer A = non-stringent wash buffer
• Wash Buffer B = stringent wash buffer

Three-stain protocols require the user to replace stain solutions as directed by the 
LCD window during staining steps.
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6. Place the microcentrifuge tube containing the SAPE stain solution into the sample 
holder, verifying that the metal sampling needle is in the tube with its tip near the 
bottom.

⇒ The Fluidics Station dialog box and the LCD window display the status of the 
washing and staining as they progress. When the wash is complete, the LCD 
window displays the message EJECT CARTRIDGE.

7. Remove microcentrifuge tube containing stain and replace with an empty 
microcentrifuge tube.

8. Remove the probe arrays from the fluidics station modules by first moving the probe 
array holder lever to the EJECT position. 

9. Check the probe array window for large bubbles or air pockets. 

� If bubbles are present, proceed to Table 2.4.3.

� If the probe array has no large bubbles, it is ready to scan on the GeneArray Scanner. 
ENGAGE wash block and proceed to Probe Array Scan on page 2.4.15. 

If you do not scan the arrays right away, keep the probe arrays at 4°C and in the dark 
until ready for scanning.

If there are no more samples to hybridize, shut down the fluidics station following the 
procedure outlined in the section, Shutting Down the Fluidics Station on page 2.4.16.

For proper cleaning and maintenance of the fluidics station, including the bleach 
protocol, refer to Section 4, Fluidics Station Maintenance Procedures.

Table 2.4.7

If Bubbles are Present

Return the probe array to the probe array holder. Latch the probe array holder by gently 
pushing it up until a light click is heard. Engage the washblock by firmly pushing up on the 
probe array lever to the ENGAGE position.
The fluidics station will drain the probe array and then fill it with a fresh volume of the last 
wash buffer used. When it is finished, if the LCD window displays EJECT CARTRIDGE 
again, remove the probe array and inspect it again for bubbles. If no bubbles are present, it is 
ready to scan. Proceed to Probe Array Scan on page 2.4.15.
If several attempts to fill the probe array without bubbles are unsuccessful, the array should 
be filled with Wash A (non-stringent buffer) manually, using a micropipette. Excessive 
washing will result in a loss of signal intensity. 
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Probe Array Scan

The scanner is also controlled by Affymetrix Microarray Suite. The probe array is scanned 
after the wash protocols are complete. Make sure laser is warmed up prior to scanning by 
turning the laser on at least 15 minutes before use. If probe array was stored at 4°C, warm to 
room temperature before scanning. Refer to the Microarray Suite online help and the 
appropriate scanner user’s manual for more information on scanning.

If necessary, clean the glass surface of probe array with a non-abrasive towel or tissue 
before scanning. Do not use alcohol to clean glass.

1. Click Run → Scanner from the menu bar. Alternatively, click the Start Scan icon in 
the tool bar.

⇒ The Scanner dialog box appears with a drop-down list of experiments that have not 
been run.

2. Select the experiment name that corresponds to the probe array to be scanned. 

A previously run experiment can also be selected by using the Include Scanned 
Experiments option box. After selecting this option, previously scanned experiments 
appear in the drop-down list.

3. By default, after selecting the experiment the number [2] is displayed in the Number of 
Scans box to perform the recommended 2X image scan.

4. Once the experiment has been selected, click the Start button.

⇒ A dialog box prompts you to load a sample into the scanner.

5. Click the Options button to check for the correct pixel value and wavelength of the 
laser beam.

For Probe Arrays with Probe Cells 24 µm or Less
� Pixel value = 3 µm

� Wavelength = 570 nm

For a 50 µm Probe Array with a Phycoerythrin Stain
� Pixel value = 6 µm

� Wavelength = 570 nm

6. Open the sample door on the scanner and insert the probe array into the holder. Do not 
force the probe array into the holder. Close the sample door of the scanner.

7. Click OK in the Start Scanner dialog box.

⇒ The scanner begins scanning the probe array and acquiring data. When Scan in 
Progress is selected from the View menu, the probe array image appears on the 
screen as the scan progresses.

The scanner uses an argon-ion laser and is equipped with a safety interlock system. 
Defeating the interlock system may result in exposure to hazardous laser light.
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Shutting Down the Fluidics Station

1. After removing a probe array from the probe array holder, the LCD window displays 
the message ENGAGE WASHBLOCK. 

2. Engage the washblock by firmly pushing up on the probe array lever to the ENGAGE 
position.

⇒ The fluidics station automatically performs a Cleanout procedure. The LCD 
window indicates the progress of the Cleanout procedure.

3. When the fluidics station LCD window indicates REMOVE VIAL, the Cleanout 
procedure is complete.

4. Remove the sample microcentrifuge tube from the sample holder.

5. If no other hybridizations are to be performed, place wash lines into a bottle filled with 
deionized water.

6. Choose Shutdown for all modules from the drop-down Protocol list in the Fluidics 
Station dialog box. Click the Run button for all modules.

The Shutdown protocol is critical to instrument reliability. Refer to the Fluidics Station 
400 User’s Guide for more information. 

7. After Shutdown protocol is complete, flip the ON/OFF switch of the fluidics station to 
the OFF position.

To maintain the cleanliness of the fluidics station and obtain the highest quality 
image and data possible, a weekly bleach protocol and a monthly decontamination 
protocol are highly recommended. Please refer to Section 4, Fluidics Station 
Maintenance Procedures for further detail.
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Customizing the Protocol

There may be times when the fluidics protocols need to be modified. Modification of 
protocols must be done before downloading the protocol to the fluidics station. Protocol 
changes will not affect runs in progress. For more specific instructions, refer to the 
Microarray Suite online help.

1. Select Tools → Edit Protocol from the menu bar.

⇒ The Edit Protocol dialog box appears.

2. Select the protocol to be changed from the Protocol Name drop-down list. 

⇒ The name of the protocol is displayed in the Protocol Name box. The conditions 
for that protocol are displayed on the right side of the Edit Protocol dialog box.

3. Select the item to be changed and input the new parameters as needed, keeping the 
parameters within the ranges shown below in Table 2.4.8.

4. To return to the default values for the protocol selected, click the Defaults button.

5. After all the protocol conditions are modified as desired, change the name of the edited 
protocol in the Protocol Name box.

6. Click Save, then close the dialog box.

Enter 0 (zero) for hybridization time if hybridization step is not required. Likewise, 
enter 0 (zero) for the stain time if staining is not required. Enter 0 (zero) for the number 
of wash cycles if a wash solution is not required.

Table 2.4.8

Valid Ranges for Wash/Stain Parameters

Parameter Valid Range

Wash Temperature for A1, B, A2, or A3 (°C) 15 to 50

Number of Wash Cycles for A1, B, A2, or A3 0 to 99

Mixes / Wash cycle for A1, B, A2, or A3 15 to 50

Stain Time (seconds) 0 to 86399

Stain Temperature (°C) 15 to 50

Holding Temperature (°C) 15 to 50

• Wash A1 corresponds to Post Hyb wash #1 in Tables 2.4.2 and 2.4.6.
• Wash B corresponds to Post Hyb wash #2 in Tables 2.4.2 and 2.4.6.
• Wash A2 corresponds to Post Stain Wash in Tables 2.4.2 and 2.4.6.
• Wash A3 corresponds to Final Wash in Tables 2.4.2 and 2.4.6.

If the protocol is saved without entering a new Protocol Name, the original protocol 
parameters will be overwritten.
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